Operate Presentation Packages

cweert GETTING TO KNOW POWERPOINT

( : INFOcus

Microsoft PowerPoint 2016 is part of the suite of programs known
as Microsoft Office. You can use PowerPoint to create and share
dynamic presentations, or slide shows as they are most commonly
called.

Before you start to use PowerPoint, let’'s spend a bit of time learning
about the PowerPoint window and its features.

In this session you will:

learn how to start PowerPoint from the desktop
learn how to create a new blank presentation
gain an understanding of the PowerPoint screen
gain an understanding of how PowerPoint works
learn how to use the ribbon

gain an understanding of Backstage view

learn how to use shortcut menus

gain an understanding of dialog boxes

learn how to launch dialog boxes

gain an understanding of the quick access toolbar
learn how to exit safely from PowerPoint.
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STARTING POWERPOINT FROM THE DESKTOP

To create or edit a presentation, you must first

start PowerPoint. If your computer uses Windows

10 it will open to the desktop. Unless you have

previously created a shortcut icon on the desktop

you will need to open PowerPoint by using either
the All apps option in the Start menu or the

Search the web and windows bar.

Try This Yourself:

Before you begin, ensure
that your computer is
switched on and the desktop
is displayed...

If there is no PowerPoint
icon in the taskbar at the
bottom of the desktop, click

0 @ Cara

Life at a glance

Freelancer.com
chemphill, these Content Writing,

Excel and Articles projects and
contests might interest you

Calendar Mail

e

Microsoft Edge

Cloudy

on the Windows icon, as

o 18
shown, to display the Start 18° i -l Na
screen Canberra Phone Compa...  OneNote
Click on All apps to display Hlayaddonioe
a list of all the apps on your

computer

C ] et
° -

Groove Music Films & TV

Scroll down to the W section

PowerPoint 2016 is listed v DOW :
here... S Investigation into deaths of
¥ NIKKEI 225 five pregnant women

Click on PowerPoint 2016 B e it .
to start Word Money News

Settings
Right-click on the Word icon ’
in the taskbar to display a
menu of options, as shown, i Allapps
then select Pin this
program to taskbar

You can now click on this
icon to open Word from the
desktop. This icon will
remain in the taskbar unless
you remove it...

Power

’;Sealch the web and Windows

Repeat step 5 to select
Close window to close
Word

Click on the Word icon in the
taskbar to open Word again

For Your Reference... Handy to Know...
To add a PowerPoint icon to the desktop e You can start PowerPoint by clicking in the
taskbar: taskbar Search... bar, typing word, then
1. Display the Start menu, then click on All clicking on PowerPoint in the list of search
apps results.
2. Right-click on PowerPoint 2016 e Pin PowerPoint to the Start menu by

displaying the All apps list, right-clicking on

3. Select Pin to taskbar 4 k :
PowerPoint 2016 and selecting Pin to Start.
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CREATING A NEW BLANK PRESENTATION

When you want to begin a new presentation, you
can choose to base the new document on an
existing template that has formatting already
applied or start with the default Blank

Presentation template and apply your own
formatting and content. All presentations are based
on a template which defines the basic layout.

Try This Yourself:

Before starting this SLpSEE RS
exercise ensure the

Education  Blue

Search for online templates and themes

Presentations

Personal

? = m}

Ivana Robinson pr“,
ivanarobinson@outlook.com rl

Switch account

X

Business  Orientation  4:3 -

PowerPoint start screen
is displayed...

On the start screen,
click on Blank
Presentation as

Blank Presentation

indicated (the first option
beneath the Search for
online templates and
themes box)

A new blank

‘ 9 Make Interactive Videos
Ta ke a with PowerPoint and Office Mix
to U r B Office Mix
‘elcome to PowerPoint Create an Office Mix
"
Y AT I R
Gallery Parcel

presentation will open,
as shown below. Notice
the document is
automatically assigned a
temporary name, which

Insert

Design

Presentation1 - PowerPoint

Transitions Animations Slide Show Review View Mlix

is displayed in the Title
G Etayout- ) O
bar 0 =l m;;ett [ =8
Paste New B I U S abk AV Shapes Arrange
o N Slide~ O oection~ o o
Clipboard Slides Font Paragraph Drawin
1
For Your Reference... Handy to Know...
To create a blank presentation: ¢ If you already have a presentation open and
1. Open PowerPoint and ensure the start want to create a new one, click on the File
screen is displayed tab to open the Backstage, click on the New
2. Click on Blank Presentation in the list of 512 GIile] SXELSISE (21 LS (PITSSISE )
templates e You can use the keyboard shortcut [cui] + [N ]
to create a new presentation based on the
Blank Presentation template.
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THE POWERPOINT SCREEN

The PowerPoint 2016 screen is made up of a
number of different components which are
described on this page. Some of these
components, such as the ribbon and Backstage
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view are common to all Office 2016 applications,
so once you know how they are used, you can
transfer this knowledge across to Microsoft Word
and Excel etc.

Presentation] - PowerPoint

Insert Design Transitions Animations Slide Show

View Mix

Ivana Robinson ]

ACROBAT Q Tell me what you want to do

s [ Layout =
9 D lj 1 Reset
New

Paste

| Clipboard =

Slide ~

5 Section -

Slides

Font

) O
P =
Shapes Arrange

Paragraph

Quick
Styles

Drawing

P Find

.aé’c Replace ~

I} Select ~
Editing

[Stide 1 of 1

1

Click to add title

Click to add subtitle

+ 58% EE}— e

= Motes W Comments [IEI e B 7 - 1
C AN

English (Australia)

Q006 66 0 © O

The File tab is used to access the Backstage view which contains file management functions, such
as saving, opening, closing, printing, sharing, and so on. There is also information contained here
such as your document Properties. Options are also available so that you can set your working
preferences.

The ribbon is the tabbed band that appears across the top of the window. It is the control centre of
PowerPoint. You use the tabs on the ribbon to access the commands that are categorised into
groups.

The Slides pane provides a preview thumbnail of each slide in your presentation. You can also use
the pane to re-order your slide sequence.

The Status bar appears across the bottom of the window. It displays the current slide number and
will display a spelling icon once you have entered text. If the document contains any spelling errors it
will be indicated on the icon.

The View buttons and the Zoom slider are used to change the view and to increase or decrease the
zoom ratio (magnification) of your slides.

The Notes and Comments tools enable you to enter notes and comments for the presenter that
won’t be seen by the audience.

The Slide window shows the content of the slide and this is also where you edit the presentation to
add effects, objects, text and so on.
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How MICROSOFT POWERPOINT 2016 WORKS

The PowerPoint 2016 screen comprises three larger entity known as a presentation which is also
key areas. The data you type is placed on a a file. Everything you do to the file is controlled in
slide. The data can be manipulated using Backstage view.

commands on the ribbon. The slide is part of a

The Slide
|f you create a hew blank o} s Presentation2 - PowerPoint Ivana Robinson
presentatlon, It WI” appear as a en Design Transitions Animations Slide Show Review View Mix CROBAT QTeHmewhatyr,\uwnodo
. . . s X = Layout - % A - =5=1=. If A Find
blank Title slide in the document | - "o walvEEEEEG O B 2 M o
window. When you click in one of - S = e B

Clipboard Slides Font Paragraph Drawing Editing

the text placeholders and type, the —
text will appear centred in the . ]
placeholder. You can also create a
new presentation from a template,
such as the health and fithess
template shown to the right, where
specific placeholders appear by
default in a number of slides so that Lt i
you can use them as a guide for —
editing and adding your own data
or images as required.

D>

3
*

s TITLE WITH PICTURES LAYOUT

SUBTITLE

*

Slide 1 of 12__English (Australia) = Notes B Comments B 5 B 7 -—14 + 5% [

The Ribbon

When you need to do something with the information on a slide, such as format it, move it, copy it, and
much more, you will find all of the relevant commands on the ribbon. The ribbon has the commands
organised thematically using a series of tabs across the top.

Presentation? - PowerPoint Ivana Robinson [Eal m}
Insert Design Transitions Anirmnations Slide Show Review Mix ACROBAT Q Tell me what you want to do ,Q+ Share
.n.D j [ Layout ~ P Y . A = 11 r<|;:. DD % Shape Fill A Find
] Reset - Shape Outline Eo Replace -
Paste New B I U S abc AV- Aa A Shapes Arrange Cuick
- Slide- o Section - - | G - = Shape Effects [+ Select -
Clipboard = Slides Font Paragraph Drawing Editing ~

Backstage View

When you want to do something
with the data in your document,
such as save it so that you can
access it again later, print it, share
it with a colleague, send it to your
boss, protect it from prying eyes,
etc, you will need to access the Sove s Printer

Microsoft Office Backstage view. BEEis B tocerton 1 documenti:
Backstage view is accessed using

Presentation2 - PowerPoint Ivana Robinson ? = o X

Print I

=) Copies: |1 :’ B
=

Print

Printer Properties

the File tab on the ribbon. Rather L

than offering commands on a (L — ‘

ribbon, Backstage occupies the B e 2

entire screen and has a series of L i e

options in an orange panel on the = ooy onenesicath. ~

left side. In our sample to the right, s O L - |
Print is active, and that is why you B B - .

can see a preview of the document
and a series of print-related
options.
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USING THE RIBBON

The ribbon is the command centre for
PowerPoint. It provides a series of commands
organised into groups that are placed on
relevant tabs. Tabs are activated by clicking on
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their name to display the command groups.

Commands are activated by clicking on a button,
tool or gallery option. Everything you could possibly
want to do in PowerPoint will be on this ribbon.

Insert

New

Slides

Design

= Layout ~
] Reset
Slide~ 0 Section~

B I

Transitions Animations Slide Show

U § abe AY

Review View

Font Paragraph

Try This Yourself: "
O
Before you begin, ensure pPaste
that PowerPoint has Clipboard
started and a blank
presentation is open... c

o Examine the groups on
the Home tab, e.g.
Clipboard, Slides,

Font etc o

Slide - -
These are the commands Slides | Tables

most commonly used...

Design

D o [ Online Pictures [ Shapes ~ i Siore

= @+ Screenshot ~

Pictures

Transitions Animations Slide Show

Recently Used Shapes

SiphotoAlbum ~ E N NOOOA L L 3G

1
e Click on the Insert tab

The commands on this tab

are used to insert items,
such as tables and
pictures...

o Click on Shapes in the
Illustrations group to
display the Shapes gallery

This includes a huge
range of shapes...

o Click on each of the tabs
and examine the
commands

Some of these commands
will open a dialog box...

o Click on the View tab,
then click on Zoom in the
Zoom group to open the
Zoom dialog box

Images

VAR S I e

Lines

SNNTLL LG %
Rectangles
OoOOotGOOOo0o

Basic Shapes
EOANOASOOOO®®
etodirLyooia
O0@AHOU XSG (3N
QG0 ) e

Block Arrows

DG IRTLPEPR IS
€ 2Vvnpn D »[REId0
Gon

Equation Shapes

TR SEA

Flowchart
O0C<eqooUgocayu
CUOn®B X ¢ AVAD
Qsio

Stars and Banners

SRS AGNOHRERaR

Review
)
dction | Comment

Comments

£
1
B

Tk TF ik TX ﬁl i [Nl Zoom
Callouts

QO 3,040 40 A Zeemte

G A0 AD GO ® Fit
Action Buttons O 005

(<[] i) o] (&) (&) [#] (=] [

Click on [Cancel], then e
click on the Home tab

00000

I
&

Percent: |73% -

For Your Reference...
To use the ribbon:
1. Click on a tab to display the commands

2. Click on a button to activate a command,
display a gallery or open a dialog box

Handy to Know...

e Additional tabs known as Contextual tabs
appear in specific circumstances. For
example, if you insert a picture or have
selected a picture, the Picture Tools:
Format tab will appear. This provides quick
access to all of the tools you may need to
modify and work with the picture.
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UNDERSTANDING BACKSTAGE VIEW

The ribbon lets you work on the content in a File tab, lets you do something with the content
presentation — you can add more content, format you create. You can save it for later use, print it on
it, insert pictures into it, copy it, and much more. paper, send it via email, and more by using the
Backstage view, which is accessed using the options found in Backstage view.

Backstage View
The File tab on the ribbon is not a

Presentation1 - PowerPoint Ivana Robinson ? — a X

normal tab — as you can tell by the
fact that it is coloured. Clicking on the

File tab launches a mini-program Info
within PowerPoint known as
BaCkStage View. BaCI.(Stage’ as. it's Protect Presentation Properties ~
known for short, occupies the entire . {: Control whet types of changes people can make to Size ey
window. Presemtaon = | T Sides )

) Hidden slides 0
At the left of the Backstage is a Saveds Tite Add atitle
navigation pane, which displays a list Svens Adobe (@ | InspectPresentation Tese Add atag

= Before publishing this file, be aware that it Categories Add a category

of options. These options provide you (e Checkfor | contains

lssues Document properties and author's name Related Dates

with access to various operations
such as printing, saving and sharing.
They can also provide you with
information about your presentation
such as the file size.

Clicking on one of the listed options
displays a range of associated
settings.

The whole underlying purpose of the

Content that people with disabilities are
unable to read Last Modified
Created Today, 1:32 PM

Last Printed

’_!j Manage Presentation
Q

Check out document or recover unsaved changes.

Manage Related People

Presentation Author

‘ ™| There are no unsaved changes,
4 Ivana Robinson

Add an author

Account LastModified By hot saved yet

Show All Properties

Options

Backstage is to enable you to protect
your data, share it with others, and
provide you with valuable information
both about your data and the status of

Backstage Options
The Backstage provide more options for working with a document

Info Provides status information about the current presentation and lets you
manage versions and permissions.
New Lets you create a new document and provides access to a gallery of
inbuilt templates as well as ready access to a range of online templates.
Open Provides a list of recent documents as well as the option to search
through your Computer, OneDrive or other place, to find what you are
looking for
Save Saves your current presentation (if already saved to a location) or Save As
prompts you to save to a location.
. X . Save as Adobe
Save As Allows you to name your presentation and save it to a location. PDF
Save as Adobe Allows you to save a Word document as a PDF document.
PDF
History Shows version history of the currently open file.
Print Lets you print the current presentation and preview it.
Share Lets you share your presentation with other people via email, online
presentation, blog or Cloud (OneDrive).
Export Allows you to create a PDF/XPS document or change the file type of
your presentation.
Close Closes your current document. s
Account Contains product and user information. Options
Options Presents you with a range of options which assist in the creation and Feedback
editing of your document.
Feedback Allows you to send feedback to Microsoft about PowerPoint.
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USING SHORTCUT MENUS

In addition to the ribbon, PowerPoint also
features shortcut menus — context-sensitive
menus that appear when you right-click on areas
of the screen or slide. Shortcut menus provide
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an (often faster) alternative method for locating
operations and commands specific to the object or
area you have right-clicked on. In some instances a
mini toolbar may also appear.

Try This Yourself:

il
Before starting this exercise , tD
ensure that you have a .

Clipboard

blank presentation open...

Slide~ |

Presentation] - PowerPoint

Animations Slide Show Review View

Customize Quick Access Toolbar...
Show Quick Access Toolbar Below the Ribbon
Customize the Ribbon...

Collapse the Ribbon

Sl Paragraph

1
Point to any of the tabs on

the ribbon, then right-click
to display the shortcut menu

This menu will display

options relating to the
toolbar and ribbon...

Click elsewhere on the slide
with the left mouse button
to close the shortcut menu

Point to one of the text
placeholders on the slide,
then right-click to display
the shortcut menu and a
mini toolbar

Because you clicked on a
text placeholder, the menu
contains Font and
Paragraph options. Cut,
Copy and Paste are greyed
out when no actual text is
selected...

Press [Esc] to close the

Calibri Li ~ 60

=,

- A'
S=a-v

B I U=

N

T

‘D Paste Options:
P
0=
Exit Edit Text

Eont...

Paragraph...
Bullets

Numbering

Convert to SmartArt

Hyperlink...

o @ o i =

Smart Lockup

Synonyrms

&

Translate

Format Text Effects...

LS

Format Shape...

menu

Right-click on an area of the

slide outside of the text
placeholders

This shortcut menu offers
slide-specific options...

Press [esc] to close the
shortcut menu

D?‘D Paste Options:

e,

bOlg
E Layout

Reset Slide

&

Grid and Guides...

Ruler

Click to add ti

Click to add subtitle

@

Format Background...

For Your Reference...
To display a shortcut menu:

1. Point to the object or area of the screen on
which you want to perform an operation

2. Right-click to display the shortcut menu

Handy to Know...

Once a shortcut menu appears, you can
select an option in it by clicking on that option
with the left mouse button.
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UNDERSTANDING DIALOG BOXES

Dialog boxes contain a series of controls that
are used to adjust settings for a particular aspect
of a document. They appear either when you
click on a dialog box launcher in the bottom
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right corner of a group on the ribbon, or when you
click on a command that displays a dialog box.
Dialog boxes are often used for adjusting some of
the more advanced aspects of a document.

Typical Dialog Box Controls

Dialog boxes have various tools to help you perform tasks. These tools are known as controls and
some typical ones are shown below.

Text boxes are
used to enter text
such as font or size.

Check boxes turn
settings either on or
off. When on they
display a tick and
therefore these
controls are also
known as tick boxes.

Font

Font  Character Spacing

Latin text font:
+Heading
Al text

Font style:
[ Regular

Font color &v Underline style | [none}

Effects

[] strikethrough

[] Double Strikethrough
[] superseript
] subscript

Offset: 0% $

|:| Small Caps
[7 ancaps
[] Equalize Character Height

Size:

Underline colar

Spinner arrows allow you to
type a specific value or use

the up or down arrows to
increase or decrease the

value respectively.

Tabs are used to
provide grouped
settings in the one
dialog box.

Drop arrows
provide a list of
options for the text
box when the arrow
is clicked. The list
“drops down” from
the arrow.

Command buttons
provide a means of
saving the changed
settings [OK], or
closing the dialog
box without
accepting any
changes made
[Cancel].
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LAUNCHING DIALOG BOXES

Dialog boxes can be launched either as a result
of clicking on a dialog box launcher or a
command button, or by selecting a command
from a menu. In a menu, the presence of three
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dots ... (an ellipsis) after a menu option indicates
that selecting the menu option will display a dialog
box. Dialog boxes are generally used for advanced
features or detailed settings.

Insert

Design

Transitions

Animations

Slide Show Mix  ACROBAT Format]

Try This Yourself: - =Ty p— e D O
N =] P Calibri Light (H~ |60 +| A A i = Q‘> O |‘_£
Before starting this exercise pete Shonr ‘Goection- | B T U SaeM-sa- [A- SESS[=- g Spehinse A
ensure that you ha_Ve a blank Clipboard Slides Font lb Paragraph [F Drawing
resentation open... Font
p p L Customize your text using advanced
) ) font and character options to give it
0 Click in a text placeholder on the exact ook you want.
the SI]de, CI|Ck on the Home You can add a variety of styles and
. a colors to your text, as well isual
tab then point to the dialog ffects, like strikethrough,
T T B R I Y o, WOROUO OO superscript, and all caps.
box launcher in the Font ¢ perseret ¢
group to display the tooltip :
e Click on the dialog box G
launcher to open the Font
dialog box e Fort 7 X
This dialog box contains Font | @harc ey
advanced options for font _ _
formatting. Click on the tabs to e e B
display more options... Alltert .
e Click on [Cance]] to close the Font calor '5;‘ Underline style | {none) ~ | Underline color -
dialog box Effects
3 g |:| Strikethrough |:| Small Caps
Let’s try a different method... [] Double Strikethrough 01l Caps
CI|Ck on the |nsert tab, then [ superseript Offset: 0% =] [ Egualize Character Height
click on Header & Footer in L] subscript
the Text group to open the
Header and Footer dialog box Cancel
e Click on [Cancel]
q Slide Si ? >
Some menu options open a e e
dialog bOX. .. Slides sized for: Crientation
v Slides
e Click on the Design tab, click i =1 O pornit
on Slide Size in the :?‘ﬁ il ® Landscape
. el .
Customise 'grOUp to Open a :9.25 12 Motes, Handouts & Outline
menu of options, then select [ S s @ Portrait
Custom Slide Size to open T B ®
the Slide Size dialog box oncal

Click on [Cancel] to close the
dialog box

For Your Reference...
To launch a dialog box:

Click on a dialog box launcher, relevant
command button or menu option

Handy to Know...

In some situations the command or dialog
box launcher actually opens a task pane.
For instance, if you click on Format
Background in the Customise group on the
Design tab, the Format Background task
pane will appear on the right side of the
screen.
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UNDERSTANDING THE QUICK ACCESS TOOLBAR

The Quick Access Toolbar, also known as the most frequently, such as Save. By default, the QAT
QAT, is the small toolbar that appears in the top also contains the Undo and Repeat buttons. You
left corner of the PowerPoint window. It is can add buttons to the Quick Access Toolbar to
designed to provide access to the tools you use make finding your favourite commands easier.

The Quick Access Toolbar

The Quick Access Toolbar is positioned in the top left corner of the Microsoft PowerPoint 2016
screen. In its default state, it includes the Save tool, the Undo tool and the Repeat tool.

The Undo tool

The Save tool The Repeat tool

H ©-0 ©®h- =

File Home Insert Transitions

Customising the Quick Access Toolbar

Appearing immediately to the right of the Quick Access Toolbar is the Customise Quick Access
Toolbar tool, as shown below. Clicking on this tool displays a list of commonly used commands that
you can add to the toolbar. You can select the items you want to add from the list by clicking on them.
The ticks that appear to the left of the menu options show which options already appear on the QAT.
You can add additional commands by selecting More Commands.

H -0 T4 -

File Home Insert

MNew

Open

Save ~

Email

Quick Print

Print Preview and Print

Spelling

v Undo

v Redo

v Start From Beginning
Touch/Mouse Mode

More Commands...

Show Below the Ribbon

You can also add commands to the Quick Access Toolbar by right-clicking on a command in the
ribbon and selecting Add to Quick Access Toolbar.

H -0 T A- = Presentation - Power

Insert  Design  Transitions  Animations  Slide Show

all - - - -—

0 Elayout~ [ irilight(-]60 | A & | 8 =
"r‘l_'IRset

Paste MNew

. ~ Slide~ O5e Add to Quick Access Toolbar

Clipboard & Slides LCustomize Quick Access Toolbar...

Show Quick Access Toolbar Below the Ribbon

1

Customize the Ribbon...

Collapse the Ribbon
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EXITING SAFELY FROM POWERPOINT

When you are finished working with PowerPoint
you will find there are several ways to exit the
application. If you have made changes to the
presentation, PowerPoint will ask you to save

Before starting this %
exercise ensure a blank
presentation is open...

o Click on the Click to add
title placeholder and type
your name

these changes before exiting. You will learn about
saving a little later on. If you don’t want to retain
any changes, you can decline the offer and simply
close the application immediately.

Try This Yourself:

John Smith‘

Click to add subtitle

This simply ensures that
you have an unsaved
change in your
presentation...

e Click on the Close button
in the top right corner of
the window

Drawing Toals O

k‘

View ACROBAT Format Q Tell me 2_ Share

You will be prompted to
save your document and

. i) d ) Shape Fill £ Find
retain the changes. ' 4 42 Shape Fi _ o
‘_’ EShape Outline~ 33 Replace -
Shapes Arrange Quick
As we have no reason for s « Styles~ ¥ ShapeEffects~ [} Select~
keeping thls ] Drawing 7] Editing

presentation, we will
decline the opportunity to
save it...

9 Click on [Don’t Save] to
exit PowerPoint

Microsoft PowerPoint *

1 ‘Want to save your changes to Presentation1?

If you click "Don’t Save”, a recent copy of this file will be temporarily available.
Learn more

Don't Save Cancel

If you click on [Save], the
Save As dialog box will
open and you will be
required to specify a file
name and location for the
presentation. Once you

have saved your

presentation, PowerPoint

will close

It is possible to have more than one presentation open at a time. If this
is the case, you need to close each one using the steps in this exercise.
Alternatively, you can right-click on the PowerPoint icon in the taskbar
and select Close all windows. This will close all presentations at once.
When the last presentation is closed, PowerPoint will terminate.

For Your Reference...

To safely exit PowerPoint 2016:

1. Click on Close

2. If you want to keep your changes, then click
on [Save] and specify a document name and
location. Otherwise, click on [Don’t Save]

Handy to Know...

e Whenever you are in doubt about whether or
not to save, you should err on the side of
caution and save the presentation. You can
delete unwanted presentations at a later
date, but you can seldom retrieve data that
has not been saved.
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